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Windows 7 was released in October.
	 Microsoft	 has	 confirmed	 that	 it	 is	 in-
vestigating	 a	 problem	 described	 as	 the	
“black	screen	of	death”,	which	affects	 its	
latest	operating	system.
	 The	error	means	that	users	of	Windows	
7	see	a	totally	black	screen	after	logging	
on	to	the	system.
	 The	firm	said	it	was	looking	into	reports	
that	suggest	its	latest	security	update,	is-
sued	on	10	November,	was	the	cause	the	
problem.
	 Reports	 suggest	 the	 flaw	 also	 affects	
Vista,	XP	and	other	systems.
	 Software	firm	Prevx,	which	has	 issued	
a	 fix	 for	 the	 problem,	 says	“millions”	 of	
people	may	be	affected.
	 “Users	have	resorted	to	reloading	Win-
dows	as	a	last	ditch	effort	to	fix	the	prob-
lem,”	the	firm’s	David	Kennerley	wrote	in	
a	blog	post.
	 “We	hope	we	can	help	a	good	many	of	
you	avoid	the	need	to	reload.”

Unknown problem
	 The	firm	said	its	fix	did	not	work	in	all	
cases.
	 “There	 can	 be	 many	 causes,”	 said	 Mr	
Kennerley.
	 “But	 if	 your	 black	 screen	woes	 began	
in	 the	 last	 two	 weeks	 after	 a	Windows	
update	or	after	running	any	security	pro-
gram	 (including	 Prevx)	 to	 remove	 mal-
ware	 during	 this	 time	 then	 this	 fix	 will	
have	a	high	probability	of	working.”
	 Mr	Kennerly	said	the	firm	had	identified	
“at	 least	 10	 different	 scenarios	 which	
will	 trigger	 the	 same	 black	 screen	
conditions”.

Microsoft investigates
Windows 7 ‘screen of death’

‘Tis the season to be jolly...
Ha ha ha ha ha... ha ha ha ha. Told you so!

12.01.09	BBC	News

“These	appear	 to	have	been	around	 for	
years	now,”	he	said.
	 The	firm	reports	that	the	problem	affects	
editions	of	Windows	7,	Vista,	XP,	NT,	and	
Windows	2000.
	 Microsoft	said	that	people	who	are	affected	
by	the	problem	should	contact	its	customer	
service	line.
	 A	 spokesperson	 said	 that	 the	 reports	
did	“not	match	any	known	issues”	docu-
mented	by	the	firm.
	 It	has	not	issued	a	fix	for	the	problem,	
which	 causes	 the	desktop,	 task	bar,	 sys-
tem	 tray	 and	 side	 bar	 to	 disappear,	 ac-
cording	to	reports.
	 The	“black	screen	of	death”	moniker	is	a	
play	 on	 the	“blue	 screen	 of	 death”,	which	
appears	when	Microsoft	operating	systems	
crash.

	 Apple’s	 lips	 are	 sealed	 about	 its	widely	
rumored	 tablet	 computer,	 but	 technol-
ogy	experts	are	giddy	about	the	device,	
already	exclaiming	 it	will	be	 the	gadget	
to	end	all	gadgets.
	 Executives	at	Apple	never	discuss	products	
that	are	 in	the	works,	so	there’s	no	con-
firmation	that	the	thing	even	exists.	But	
rumors	 are	 circulating	 that	 Steve	 Jobs	
and	Co.	have	designed	a	magazine-sized,	
touch-screen,	 hand-held,	 all-in-one	 de-
vice	 that	 is	 half-iPhone,	 half-Macintosh	
computer.
	 It’s	 supposedly	 going	 to	make	 its	 de-
but	in	the	next	few	months,	and	you	can	
have	it	for	the	low,	low	price	of	$600.	Or	
$800.	Maybe	$1,000.	No	one’s	really	sure.

Apple tablet: One tech gadget 
for all
The rumored and much-hyped tablet computer 
from Apple could lay waste to the markets for 
countless other gadgets.
11.16.09	
David	Goldman,	CNNMoney.com

If	 the	rumors	are	true,	 the	tablet	will	be	
able	to	do	basically	everything	a	gadget	
could	possibly	do.	It’s	an	e-reader,	a	gam-
ing	device,	 and	 a	music	 player.	You	 can	
watch	TV	and	movies	on	it	and	surf	the	
Internet	 (or	 so	we’ve	 heard).	 And	 it	will	
have	thousands	of	third-party	apps	avail-
able	for	it	...	or	maybe	it	will	run	Mac	OS	
X.	That’s	all	still	unknown.
	 Coolest	 device	 ...	 ever?	 Maybe.	 Some	
analysts	are	channeling	their	inner-Frodo,	
saying	 the	Apple	 tablet	will	 be	 the	one	
gadget	to	rule	them	all.
	 “This	will	 be	 the	 next	 big	 thing,”	 said	
Laura	DiDio,	principal	analyst	at	ITIC.	“Ap-
ple	is	going	to	wow	everybody	with	the	
tablet.”
	 Any	time	Steve	Jobs	gets	on	stage,	the	
expectations	are	incredibly	high,	but	they	
are	especially	lofty	for	the	tablet.	Analysts	
and	investors	are	saying	that	this	device	
could	 revolutionize	 the	 handheld	world	
in	the	same	way	the	the	iPhone	changed	
the	smartphone	market.
	 “The	tablet	will	change	the	game,	be-
cause	Apple	will	throw	down	the	gaunt-
let	at	the	competitors,	and	force	them	to	
follow	along,”	DiDio	said.
	 According	to	DiDio,	the	tablet	will	have	
a	 10-inch	 to	 12-inch	 screen	 and	 a	 high-
end	graphics	card	that	will	enable	stun-
ning	resolution	--	even	more	so	than	the	
iPhone	and	iPod	Touch.	She	said	the	de-
vice	will	 come	 in	 several	different	mod-
els	 that	 offer	 varieties	 of	 Internet	 con-
nections,	 such	 as	 Wi-Fi	 or	 3G,	 perhaps	
through	a	contract	with	AT&T.
	 Another	 cool	 feature	will	 be	 the	Web	
cam,	which	business	travelers	will	be	able	
to	use	for	video	conferencing	on	the	go,	
DiDio	said.
	 Some	analysts	say	all	of	those	features	
will	 kill	 other	 single-function	 handheld	
devices,	 making	 the	 Apple	 tablet	 the	
go-to	 handheld	 device	 for	 computing,	
Internet	 browsing,	 reading,	 gaming	 and	
entertainment.
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	 Apple	took	what	could	be	a	step	toward	
adding	 a	 subscription-based	 music	
services	 to	 its	 offerings	 Friday	 when	 it	
bought	Lala,	a	company	that	delivers	mu-
sic	via	the	Web	to	its	users.
	 Rumors	 circulated	 around	 the	 Web	
throughout	Friday	that	Apple	was	in	talks	
to	 buy	 Lala.	 The	 New	 York	 Times	 con-
firmed	 the	purchase	 late	Friday,	 citing	a	
person	with	knowledge	of	the	deal.
	 The	Wall	Street	Journal	also	reported	the	
Lala	purchase	as	a	done	deal.	“Apple	buys	
smaller	technology	companies	from	time	
to	time	and	we	generally	do	not	comment	
on	our	purpose	or	plan,”	Apple	spokesman	
Steve	Dowling	told	the	Journal.
	 Neither	 the	 Times	 nor	 the	 Journal	 could	
reach	Lala	representatives	to	confirm	the	deal.
	 The	 Lala	music	 service	 could	 now	 be	
owned	by	Apple,	according	to	a	New	York	
Times	report.
	 Based	in	Palo	Alto,	Calif.,	Lala	lets	users	lis-
ten	to	a	catalog	of	around	8	million	songs	
for	free	through	the	Web.	According	to	La-
la’s	site,	users	can	pay	10	cents	for	unlimited	
plays	of	a	song;	they	can	also	download	an	
MP3	version	for	89	cents.	The	MP3s	come	
without	digital-rights	management	restric-
tions,	making	them	compatible	with	iTunes	
and	Windows	Media	Player.
	 If	Lala	 is	now	part	of	 the	Apple	 fold,	 it	
would	 mark	 a	 departure	 from	 the	 ap-
proach	 that	 Apple	 has	 taken	 to	 music	
since	launching	the	iTunes	Store	in	2003.	
The	iTunes	Store	has	always	offered	music	
on	an	a	 la	 carte	basis,	with	users	paying	
to	 download	 specific	 tracks	 and	 albums.	
Apple	 executives—including	 CEO	 Steve	
Jobs—have	 repeatedly	 argued	 that	 cus-
tomers	 like	to	own	their	music.	“Custom-
ers	 don’t	 seem	 to	 be	 interested	 in	 [sub-
scription-based	music	services],”	Jobs	told	
Reuters	 in	 an	 April	 2007	 interview.	“The	
subscription	model	has	failed	so	far.”
	 More	than	two	years	later,	that	may	no	lon-
ger	be	the	case.	While	the	iTunes	Store	contin-
ues	to	thrive—the	online	store	became	the	

nation’s	top	music	retailer	in	2008—subscrip-
tion-based	 services	 like	 Rhapsody	 (which	
even	offers	an	iPhone	app)	and	Spotify	in	Eu-
rope	are	carving	out	their	own	share	of	the	
digital	music	market.	Apple’s	interest	in	Lala	
could	be	a	sign	that	the	company	wants	to	
expand	 beyond	 its	 pay-per-download	 ap-
proach	to	music.

	 Despite	all	of	the	advances	in	digital	tech-
nology,	 too	 few	 high-tech	 products	 have	
emerged	to	help	the	blind	read	books	or	oth-
er	paper	documents,	or	to	make	reading	such	
texts	easier	for	people	with	impaired	vision	or	
language-related	learning	disabilities.
	 A	 few	 years	 back,	 a	 breakthrough	 was	
made	 with	 text-to-speech	 software	 that	
could	be	installed	on	a	specific	mobile	phone,	
but	with	limitations	due	to	the	phone’s	small	
screen	and	buttons,	and	restricted	processor	
power.
	 Now,	Intel	the	giant	chip	maker,	is	attacking	
this	problem	with	a	new	product:	the	Intel	
Reader.	 It’s	a	chunky,	book-size	device	with	
a	 computer-grade	 processor	 and	 a	 large,	
forward-facing	 screen	 that	 can	 be	 viewed	
easily	while	 its	downward-facing	camera	 is	
shooting	text	for	translation	into	audio	and	
giant	text.	It	also	has	raised	buttons	that	are	
easy	to	find	via	touch.
	 I’ve	been	testing	the	Intel	Reader	with	
books,	 newspapers,	 magazines,	 bank	
statements,	menus	and	even	cereal	boxes.	
My	results	were	decidedly	mixed.	In	some	
cases,	 especially	with	 books	 and	 certain	
magazine	 articles,	 it	worked	pretty	well,	
often	almost	perfectly.	 In	others,	 it	did	a	
poor	job.	I	also	found	that	it	takes	a	lot	of	
practice	to	learn	how	to	aim	the	Reader’s	
camera	properly.
	 However,	an	important	caveat	is	in	order.	
I	have	full,	normal	vision	and	no	learning	
disabilities,	 so	 I	 can’t	 put	 myself	 in	 the	

Intel Makes Leap in Device to 
Aid Impaired Readers
11.18.09	
Walter	S.	Mossberg,	
Wall	Street	Journal

continued from p. 1

	 “Apple	will	come	out	with	the	tablet	and	
blow	everyone	away,”	 said	Dan	Ackerman,	
senior	editor	at	CNET.	“Instead	of	taking	along	
a	Kindle	and	an	iPod,	that	[tablet]	could	be-
come	the	device	you	carry	with	you.”
The	cheaply	priced	netbook	market	may	
also	take	a	hit	when	the	tablet	comes	out.	
Apple	typically	prices	their	products	high-
er	than	competitors,	because	they	install	
top-of-the-line	hardware,	but	DiDio	said	
Apple	learned	from	its	mistake	of	pricing	
the	original	 iPhone	 at	 $599,	 pricing	out	
many	potential	customers.
	 “The	 Tablet	 will	 be	 awesome,	 and	
my	 guess	 is	 that	 it	 will	 be	 an	 instant	
hit	 for	 people	 who	 loved	 Kindles	 and	
people	who	want	netbooks,”	 said	David	
Wertheimer,	 executive	 director	 of	 the	
University	of	Southern	California’s	Enter-
tainment	Technology	Center.
	 Wertheimer	 said	 he	 finds	 it	 hard	 to	
comprehend	how	the	tablet	will	replace	
all	 other	 on-the-go	 tech	 products.	 “But	
then	 again,	 what	 I	 can’t	 imagine,	 Steve	
Jobs	often	can,”	he	added.
	 ...Or	 the	 fizzle	 may	 fail.	 Not	 everyone	
thinks	the	Apple	tablet	will	be	the	gadget	
to	end	all	gadgets.
	 “What	 we’ve	 found	 in	 the	 past	 with	
these	multi-function	devices	is	that	they’re	
better	for	ad-hoc	purposes,	like	quick	and	
dirty	tasks,”	said	Zeus	Kerravala,	an	analyst	
with	Yankee	 Group.	“They’re	 not	 for	 any	
prolonged,	high-performance	use.”
	 For	 instance,	 smartphones	 have	 cam-
eras	 for	 quick	 snapshots,	 but	when	 you	
go	on	vacation,	you’re	probably	going	to	
want	your	digital	camera	to	come	along	
with	you	for	high-quality	photos.
	 Kerravala	 said	 the	 same	 logic	 applies	
to	the	tablet’s	other	functions,	including	
its	e-reading	capability:	“If	you	want	to	sit	
and	read	a	book,	the	ergonomics	of	a	de-
vice	that’s	specifically	designed	for	read-
ing	are	going	to	be	better.”

Apple Tablet

	 Similarly,	 only	 3%	 of	 people	
whose	cell	phones	can	play	music	
say	 they	 use	 their	 phone	 as	 their	
primary	music	player,	according	to	a	Yan-
kee	Group	study.	Even	if	 it	means	carry-
ing	around	two	devices,	an	MP3	player	is	
bound	to	have	a	better	user	experience	
than	a	multi-function	cell	phone.
	 That	doesn’t	mean	the	Apple	tablet	 --	
if	 it	exists	--	won’t	be	cool.	But	you	may	
want	to	hang	onto	your	iPod,	Kindle,	Nin-
tendo	DS,	portable	DVD	player	and	 lap-
top	for	a	while.

Apple reportedly buys 
Lala music service
12.04.09	
Philip	Michaels,	Macworld.com
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	 Here	 are	 a	 few	 situations	 when	 it’s	
worth	it	to	split	up	your	hard	disk.
	 When	you	get	a	new	Mac,	it	comes	with	
one	startup	drive	(a	hard	disk	or,	in	a	few	cas-
es,	a	solid-state	disk)	named	“Macintosh	HD.”	
This	arrangement	is	perfectly	fine	for	most	of	
us,	but	it’s	not	your	only	option.	If	the	need	
arises,	you	can	split	that	disk	up.	Any	internal	
(IDE	or	SATA)	or	external	 (FireWire,	USB,	or	
eSATA)	disk	can	be	reorganized	into	one	or	
more	volumes	called	partitions.
	 Each	partition	appears	on	your	Desktop	
as	 an	 independent	 disk,	 and	 you	 can	
even	 mix	 and	 match	 formatting	 meth-
ods	from	one	partition	to	the	next	on	the	
same	disk.	You	can	use	Disk	Utility	(found	
in	 /Applications/Utilities)	 to	 repartition	
a	 drive,	 although	 doing	 so	 normally	 re-
quires	erasing	the	entire	drive	in	the	pro-
cess.	 You	 can	 also	 choose	 from	 several	
third-party	utilities,	such	as	Prosoft	Engi-

Five reasons to partition a disk
Joe	Kissell,	Macworld.com

neering’s	$99	Drive	Genius	2	and	Coriolis	
System’s	$45	iPartition	that	can	change	a	
drive’s	partitioning	without	erasing	it.
	 I	know	some	people	who	have	partitioned	
their	Macs’	hard	drives	for	decades,	but	can’t	
really	give	a	good	reason	for	doing	it.	Parti-
tioning	can	waste	space	and	even	decrease	
your	hard	drive’s	performance.	So	why	would	
you	ever	bother?	Here	are	five	good	reasons:

1. To switch between versions of OS X
	 If	your	Mac	is	capable	of	running	multiple	
versions	of	OS	X	(for	example,	you	have	an	ear-
ly	Intel-based	iMac	that	can	run	Tiger,	Leopard,	
or	Snow	Leopard),	you	can	partition	your	drive	
so	that	you	can	use	more	than	one.	Divide	your	
disk	into	one	partition	for	each	version	of	OS	
X,	and	then	install	the	operating	systems	sepa-
rately.	When	you	need	to	run	a	different	ver-
sion	of	the	operating	system—say,	for	testing,	
or	to	use	older	software	that	won’t	run	under	
a	newer	OS—open	the	Startup	Disk	pane	of	
System	 Preferences,	 select	 the	 partition	 you	
want,	and	click	on	Restart.

2. To use Boot Camp
If	you	use	Boot	Camp	Assistant	(built	into	
OS	X	10.5	Leopard	and	later)	to	run	Windows	
on	your	Mac,	it	creates	a	special	partition	
just	for	your	Windows	installation.	Unfor-
tunately,	Boot	Camp	Assistant	won’t	work	
if	 your	 disk	 is	 already	 partitioned,	 so	 if	
you	intend	to	use	Boot	Camp,	you’ll	have	
to	stick	 to	 just	 two	partitions	 (one	each	
for	Windows	and	OS	X).

3. To repair disk problems
	 If	your	startup	volume	develops	disk	errors,	
you	may	need	to	run	a	repair	program	(such	as	
Disk	Utility)	from	another	volume	in	order	to	fix	
them.	That	other	volume	could	be	an	external	
hard	drive	or	a	bootable	DVD.	But	another	op-
tion	is	to	keep	a	small	partition	on	your	main	
disk	that	includes	a	bootable	copy	of	OS	X	and	
a	repair	utility	or	two.	When	trouble	strikes,	you	
can	boot	up	from	this	volume	and	fix	some	
problems	without	having	any	secondary	me-
dia	at	all.

4. To share your iPhoto library
	 If	 you	 want	 to	 share	 a	 single	 iP-
hoto	library	between	two	or	more	user	ac-
counts	on	the	same	Mac,	one	way	to	do	
so,	per	Apple’s	advice,	 is	 to	move	 it	 to	a	
volume	where	ownership	is	ignored.	That	
can’t	 be	 your	main	 startup	 volume,	 but	
it	could	be	an	external	disk—or	another	
partition	of	your	internal	disk.

5. To manage backups efficiently
	 I	 recommend	 maintaining	 two	 kinds	 of	
backups.	The	 first	 is	 bootable	 duplicates	 of	
your	 entire	 disk,	 using	 a	 program	 such	 as	
Bombich	Software’s	Carbon	Copy	Cloner	(do-
nation	requested)	or	Shirt	Pocket	Software’s	
$28	 SuperDuper!.	 The	 second	 is	 versioned	
backups	(which	store	copies	of	your	files	as	
they	appeared	at	many	points	in	time)	using	
Apple’s	built-in	Time	Machine	or	any	of	nu-
merous	other	backup	utilities.	You	don’t	need	
to	keep	two	different	hard	drives	around	for	
your	two	types	of	backup.	Instead,	use	parti-
tions.	For	example,	if	you	have	a	1TB	internal	
disk,	you	could	buy	a	single	2TB	external	drive,	
divide	it	into	two	1TB	partitions,	and	then	put	
your	bootable	duplicate	on	one	while	using	
the	other	for	versioned	backups.
	 Disk	Utility	lets	you	divide	one	physical	
disk	into	multiple	partitions.

Ten quick Calculator tricks
Here’s how to get the most out of Apple’s 
built-in tool
by	Sharon	Zardetto,	
Macworld.com

	 The	 lowly	 Calculator	 sits	 there	 in	
your	Applications	folder.	It’s	so	unassum-
ing	you	barely	notice	 that	 it	has	menus	
and	little	interface	details	that	make	it	not	
quite	so	lowly	after	all.	These	tips	work	for	
the	Basic	 calculator.	Many	 also	work	 for	
the	 Scientific	 and	 Programmer	 versions	
available	 through	 the	 Calculator’s	 View	
menu.
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TarMac Tipsplace	of	 someone	who	 is	 unable	 to	 read	
paper	documents,	or	who	struggles	to	do	
so.	For	them,	the	limitations	I	found	in	this	
product	might	easily	pale	when	compared	
with	 its	 liberating	benefits.	More	 informa-
tion	is	at	reader.intel.com.
	 When	 it	 worked	 as	 promised,	 the	 Intel	
Reader	was	a	delight.	It	would	start	reading	
the	text	to	me	in	under	a	minute,	while	dis-
playing	the	words	on	the	4.3-inch	screen	in	
an	easily	adjusted	font	size	that	could	allow	
as	little	as	one	word	to	fill	the	display.	I	also	
could	switch	to	a	view	of	the	photo	of	the	
whole	page,	and	zoom	in	to	focus	on	a	por-
tion	of	the	text.	It	holds	multiple	texts	and	
has	an	easy	interface	with	large	menus	that	
the	machine	can	read	to	you.
	 But	the	Reader	is	relatively	big	and	ex-
pensive.	It	costs	a	whopping	$1,500	and	
is	 available	 from	only	 a	 limited	number	
of	retailers	who	specialize	in	products	for	
special-needs	consumers.	By	contrast,	the	
competing	cellphone	product,	called	the	
KNFB	mobile	reader,	is	much	smaller	be-
cause	it	uses	a	standard	Nokia	(NOK)	mo-
bile	phone.	It	can	be	purchased	through	
Amazon.com	(AMZN),	also	for	$1,500.

Intel Device to Aid
Impaired Readers
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	 Snow	Leopard	 changed	a	 lot	of	 small	
things	in	the	system,	and	not	all	of	these	
were	detailed	by	Apple.	One	such	change	
occurs	when	you	use	minimized	windows	
with	Spaces	(Apple’s	tool	to	create	virtual	
desktops).	 In	 OS	 X	 10.5,	 when	 releasing	
(unminimizing	 just	 sounds	 so…wrong)	
a	 minimized	 window	 from	 the	 Dock,	 it	
would	 spring	back	 into	whatever	 Space	
it	started	on,	switching	to	that	Space	as	it	
activated	the	newly-released	window.
	 While	this	may	be	desired	behavior	most	
of	the	time,	it	could	be	jarring	if	you’d	got-
ten	involved	in	another	Space,	and	sudden-
ly	 found	yourself	 looking	at	your	released	
window	in	a	totally	different	Space.
	 In	10.6,	it	seems	that	things	still	work	as	
they	did	in	10.5,	at	least	when	you	click	on	
a	 minimized	 window’s	 Dock	 icon.	 Note	
that	this	tip	only	applies	if	you	have	not	
implemented	Snow	Leopard’s	new	“mini-
mize	into	application	icon”	feature—that	
is,	your	minimized	windows	still	show	up	
on	the	right-hand	side	of	the	Dock.
	 Here’s	 the	 trick:	 Command-click	 on	 a	
minimized	 window	 in	 the	 Dock,	 and	 it	
will	be	released	into	the	current	Space	in-
stead	of	into	its	originating	Space.	Snow	
Leopard	makes	both	behaviors	available,	
hopefully	satisfying	the	needs	of	anyone	
who	 minimizes	 windows	 to	 the	 right-
hand	 side	 of	 the	 Dock.	 I’m	 not	 aware,	
though,	of	any	way	to	toggle	the	behav-
ior	 of	 click	 and	 Command-click,	 so	 that	
you	 could	 release	 a	minimized	window	
into	the	current	Space	with	a	single	click.

Open minimized windows in 
current space in Snow Leopard
11.17.09
Rob	Griffiths,	Macworld.com

	 Among	 the	 many	 improvements	 in	
Snow	Leopard	is	the	ability	to	use	the	Tab	
key	 in	 user-created	 keyboard	 shortcuts.	

Use Tab key in Snow Leopard 
keyboard shortcuts
11.19.09
Rob	Griffiths,	Macworld.com

In	OS	X	10.5,	pressing	the	Tab	key	while	
creating	keyboard	shortcuts	(in	the	Key-
board	 Shortcuts	 tab	 of	 the	 Keyboard	 &	
Mouse	System	Preferences	panel)	didn’t	
work;	 the	 system	 would	 just	 beep	 and	
not	accept	the	Tab	key.
	 Snow	 Leopard	 changes	 all	 that;	 you	
can	now	use	 the	Tab	key	 in	any	combi-
nation	with	the	Shift,	Control,	Command,	
and	Option	keys.	For	example,	you	could	
change	 the	 Exposé	 All	 Windows	 acti-
vation	 keystroke	 to	 Option-Tab,	 which	
might	make	 sense	 if	 you’re	 used	 to	 us-
ing	Command-Tab	to	switch	applications	
and	 want	 to	 have	 a	 similarly-assigned	
shortcut	for	Exposé.
	 Just	open	the	Keyboard	Shortcuts	tab	
of	 the	 Keyboard	 System	 Preferences	
panel,	 select	 the	Exposé	&	Spaces	entry	
in	the	left-hand	column,	then	click	on	the	
All	Windows	 entry	below	Exposé	 in	 the	
right-hand	 column.	 Double-click	 on	 the	
right-hand	side	of	that	entry	(it	will	prob-
ably	 say	 F9	 by	 default),	 then	 just	 press	
Option-Tab,	and	you’re	done.
	 This	 is	 but	 one	 contrived	 example,	 of	
course.	The	bigger	 picture	 is	 that	 you	 can	
now	use	 the	Tab	key	 in	your	user-defined	
shortcuts,	which	opens	up	a	number	of	ad-
ditional	keyboard	combinations.	If	you’re	cre-
ating	something	that’s	system-wide,	though,	
keep	 in	mind	 that	 other	 applications	may	
already	be	using	 the	Tab	key	 in	 their	own	
shortcuts.	In	Safari,	for	instance,	Control-Tab	
(and	Shift-Control-Tab)	are	already	used	 to	
switch	between	tabs.

	 No	 matter	 how	 much	 you	 enjoy	 tak-
ing	 digital	 photos	 and	 sharing	 them	
electronically,	 there’s	 something	 spe-
cial	about	photos	 that	you	hold	 in	your	
hand.	These	days,	it’s	popular	to	let	some-
one	else	make	prints	 for	you—be	 it	 the	
neighborhood	 camera	 store,	 Wal-Mart,	
or	an	online	photo	service	like	Shutterfly.	
But	there	are	advantages	to	printing	your	
photos.	For	one	thing,	you	don’t	have	to	
wait	for	prints	to	arrive	in	the	mail.	And	if	
a	print	doesn’t	 come	out	 the	way	you’d	

Get better prints
Four steps to getting the best 
results from your inkjet printer
11.12.09
Dave	Johnson	&	Kelly	Turner,	Macworld.com

like,	you	can	adjust	the	image	and	
print	again	without	having	to	send	
it	 off	 to	 someone	 else.	 (If	 you’re	
seeing	strange	lines	or	bad	colors,	see	our	
printer	troubleshooting	guide.)
	 Here	are	some	tips	for	getting	the	best	
results	from	your	inkjet	printer.

Start with enough pixels
	 This	 probably	 isn’t	 a	 big	 concern	 for	
photos	 you	 take	 with	 your	 digital	 cam-
era;	 most	 modern	 digital	 cameras	 offer	
more	 than	 enough	 resolution	 to	 make	
prints	of	any	size	you’d	want.	But	 if	 you	
get	 an	 image	file	 from	 someone	 else—
especially	 through	 e-mail—you	 should	
check	 the	 resolution	before	you	print	 it.	
Often,	shared	photos	are	resized	to	take	
up	less	space,	and	that	can	result	in	pixi-
lated	prints.
	 If	 you’re	 ordering	 prints	 online	 from	
iPhoto,	the	program	will	 let	you	know	if	
there	aren’t	enough	pixels	 for	a	smooth	
print.	But	you	won’t	get	the	same	heads-
up	when	printing	 to	 your	 inkjet	 printer,	
so	 you’ll	 want	 to	 double	 check	 the	 im-
age	size.	First,	decide	what	print	size	you	
want.	Then	multiply	 the	 longest	 side	by	
200.	The	resulting	number	represents	the	
minimal	 number	 of	 pixels	 the	 longest	
side	of	your	image	needs	to	have.	If	you’re	
trying	to	make	an	8-by-10-inch	print,	for	
example,	the	 longest	side	of	the	picture	
should	be	2000	pixels	or	more.	If	it’s	not,	
then	you	should	consider	printing	it	at	a	
smaller	size.
	 In	iPhoto,	you	can	see	an	image’s	pixel	
dimensions	in	the	Information	pane.
	 To	 determine	 the	 size	 for	 photos	 not	
in	 iPhoto,	open	 the	 folder	 that	 contains	
the	photo	and	press	Command-I	to	open	
a	 Get	 Info	 window.	 You’ll	 see	 the	 pixel	
dimensions	 listed	 under	 the	 More	 Info	
heading.

Crop to Size
	 The	next	step	 is	 to	crop	the	 image	to	
the	 correct	 aspect	 ratio.	 Every	 common	
print	size—such	as	4	by	6,	5	by	7,	and	8	
by	10—has	slightly	different	proportions.	
And	 they’re	 all	 different	 from	 the	 stan-
dard	digital	photo	aspect	ratio.	So	if	you	
don’t	crop	your	photo	ahead	of	time,	you	
might	end	up	printing	a	different	part	of	
the	image	than	you	expected.
	 If	you’re	in	iPhoto,	you	can	use	the	editing	
pane’s	Crop	 tool.	But	keep	 in	mind	 that	
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changes	you	make	here	are	reflected	ev-
erywhere	the	image	appears—including	
books,	 calendars,	 prints,	 and	 smart	 al-
bums.	A	better	option	is	to	use	the	resizing	
tool	included	in	iPhoto’s	Print	dialog	box.
	 Select	the	photo	from	your	library	and	
choose	File	->	Print.	Choose	a	print	tem-
plate	 (use	 Standard	 for	basic	borderless	
prints),	 and	 then	make	 the	 appropriate	
selections	from	the	Paper	Size	and	Print	
Size	menus.	This	tells	iPhoto	what	you’re	
trying	 to	 accomplish	 so	 it	 uses	 the	 cor-
rect	aspect	ratio.	Next,	click	Customize	to	
adjust	how	your	image	is	cropped.	In	the	
resulting	 screen,	 click	 once	 on	 your	 im-
age	and	use	the	zoom	slider	to	determine	
how	much	of	the	image	appears	and	the	
hand	tool	to	reposition	the	photo	within	
the	frame.
	 To	crop	a	photo	for	a	specific	print	size,	
first	press	Command-P,	and	then	choose	
the	correct	paper	and	print	size	from	the	
Print	dialog	box.
	 Use	the	zoom	slider	(seen	at	the	top	of	
the	image)	in	the	Customize	pane	to	crop	
the	photo	for	the	selected	print	size.

Sharpen the Image
	 The	Print	window	also	lets	you	apply	a	lit-
tle	extra	sharpening	right	before	you	print.
	 Most	 of	 the	 time,	 digital	 photos	 will	
benefit	from	a	small	amount	of	sharpen-
ing	before	you	print	them.	If	your	digital	
camera	 has	 a	 setting	 to	 automatically	
sharpen	your	images	when	they’re	taken,	
you	might	want	to	experiment	with	that	
and	see	if	you	like	the	effect.	 In	general,	
many	 cameras	 take	 slightly	 better	 pic-
tures	with	the	sharpening	set	to	the	low-
est	level	other	than	zero,	such	as	+1.
	 If	 your	 camera	 doesn’t	 have	 its	 own	
sharpening	filter,	or	 if	you	choose	not	 to	
use	it,	then	apply	a	small	amount	of	sharp-
ening	 before	 you	 start	 printing.	 Again,	
while	you	can	do	this	within	iPhoto’s	edit-
ing	pane,	your	changes	will	apply	to	every	
instance	of	 that	photo.	 If	 that’s	not	what	
you	want,	you	can	also	perform	this	task	
right	before	printing.	From	the	Customize	
pane	of	the	Print	window,	click	once	of	the	
photo	 and	 then	 click	 the	 Adjust	 button.	
Adjust	the	Sharpness	slider	to	get	the	ef-
fect	you	want,	and	then	choose	Print.	Your	
original	image	will	remain	untouched.

Keep Your Printer Happy
	 Now	you’re	ready	to	print.	You’ll	typical-
ly	get	 the	most	 reliable	 results	by	using	
the	paper	and	ink	recommended	by	your	
printer’s	manufacturer.	If	you	have	an	Ep-
son	printer,	for	instance,	use	Epson	paper	
and	 Epson	 ink.	 The	 combination	 might	
cost	a	bit	more,	but	all	those	components	
are	engineered	to	work	together	and	the	
results	 are	 noticeably	 better	 than	 what	
you	get	from	less	expensive	alternatives.
	 That	 said,	 there	 are	 a	 number	 of	 high-
quality	third-paper	photo	papers	that	of-
fer	 interesting	 textures	 and	professional	
finishes,	if	you’re	willing	to	experiment	(see	
our	roundup	of	unusual	papers	for	some	of	
our	favorites).	You’ll	likely	spend	a	bit	more	
money	and	time	working	with	these	papers,	
but	the	results	can	be	worth	it.
	 Be	sure	to	set	the	printer	settings	to	reflect	
the	 kind	 of	 paper	 you’ve	 loaded	 in	 your	
printer,	 and,	 if	 you	 have	 a	 choice,	 set	 the	
printer	for	quality,	not	print	speed.

1. Copy and paste numbers
	 Need	to	 include	a	quick	calculation	 in	
an	 e-mail	 message?	 Because	 you	 can’t	
select	anything	in	the	Calculator	display,	
it’s	easy	to	forget	you	can	still	use	Copy	
and	 Paste	 commands	with	 it.	 The	 Copy	
command	(Command-C	or	Edit	->	Copy)	
always	 grabs	 the	 currently	 displayed	
number	and	places	it	on	the	Clipboard	so	
you	can	use	 it	 elsewhere.	And,	 if	 you’ve	
copied	 a	 number	 from	 someplace	 else,	
just	 use	 Paste	 (Command-V	 or	 Edit	 ->	
Paste)	when	the	Calculator’s	open	to	in-
sert	 the	 number	 in	 the	 Calculator	 field.	
(Many	OS	versions	ago,	you	could	paste	
in	a	 calculation	 like	17*34,	 and	 it	would	
appear	in	Calculator	as	if	you	had	clicked	
those	keys;	now	that	calculation	pastes	in	
as	the	number	1734.)

2. Pick your precision
	 If	kiwis	are	selling	3	for	$5,	does	one	of	
them	cost	$1.66667?	When	you	don’t	need	
15-decimal	place	precision,	use	the	View	
menu’s	Decimal	Places	submenu	to	spec-
ify	how	many	digits	you	want	displayed.	

The	displayed	number	is	rounded,	
not	truncated,	so	1.66667	becomes	
1.67.	 The	 actual	 number	 is	 stored	
internally,	 however,	 so	 you	 can	 contin-
ue	with	a	 calculation	 that	uses	 the	 true	
number	instead	of	the	rounded	one.

3. Convert units of measure
You	may	never	have	to	convert	hectares	
to	acres,	or	inches	of	mercury	to	pounds	
per	 square	 inch,	 but	 the	 Convert	menu	
provides	more	mundane	changes,	too.	For	
example,	use	it	to	convert	metric	units	to	
any	of	the	stubbornly	held	standard	mea-
surements	the	U.S.	uses.	Enter	a	number	
(or	work	with	the	one	already	there	from	
a	calculation)	and	then	choose	a	catego-
ry	from	the	menu—Length,	for	example.	
Use	the	pop-up	menus	in	the	sheet	that	
appears	 to	 specify	what	 you’re	 convert-
ing	 to	and	 from.	The	Calculator	displays	
the	answer	in	the	chosen	units.

4. Repeat the last calculation
	 With	 the	 Calculator’s	 hidden	 “repeat	
the	 last	 operation”	 function,	 it’s	 a	 cinch	
to	 compute	 something	 like	 short-term	
compound	 interest.	Start	with	1200	dol-
lars	times	1.06	for	the	first	year’s	6	percent	
return	and	you	get	1272.	Just	hit	Return	
again,	 and	 the	 number	 is	multiplied	 by	
1.06	again;	another	press	of	Return	gives	
you	the	third-year	total	of	1429.22.
	 Alternatively,	you	can	enter	numbers	in	
between	 the	 repeated	operation.	So,	af-
ter	 the	first	calculation	 is	done,	you	can	
enter	1500	and	press	Return	 to	get	 that	
number	multiplied	by	1.06.

5. Use the paper tape
	 The	paper	tape	window	not	only	serves	
as	a	quick	reference,	it	can	also	be	printed	
or	saved.	This	shows	the	result	of	the	spe-
cial	“repeat	last”	function,	which	uses	re-
peated	clicks	of	the	equal	sign	(=)	key	to	
perform	the	same	operation—*1.06	was	
entered	only	once.
	 The	Window	->	Show	Paper	Tape	com-
mand	opens	a	small	window	that	shows	
each	of	your	calculations	as	soon	as	you	
press	 Return	 or	 click	 on	 the	 equal	 sign	
(=)	key.	This	lets	you	check	for	incorrectly	
entered	numbers.	If	you	realize	you	want	
to	see	your	history	only	after	the	fact,	no	
problem:	Any	 time	 you	 open	 the	 paper	
tape,	 you’ll	 see	 everything	 you’ve	 done	
since	you	opened	the	Calculator	 for	 the	
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current	number-crunching	session.	If	you	
need	 a	 copy	 of	 the	 paper	 tape,	 choose	
File	->	Save	Tape	As	or	File	->	Print	Tape.	
You	can	also	select	any	part	of	its	display	
and	copy	out	the	information.

6. Store a number
	 You’re	 figuring	 out	 the	 cost	 of	 tiling	
the	kitchen,	with	and	without	the	pantry	
closet,	and	maybe	the	back	hallway,	too.	
You	don’t	have	to	re-enter	the	$6.47-per-
square-foot	cost	of	 the	tile	 for	 the	three	
different	calculations.
	 Enter	6.47	and	press	M+	to	put	 it	 into	
memory.	Then,	calculate	the	cost	of	each	
area’s	tile	by	multiplying	the	square	foot-
age	by	the	stored	tile	price,	retrieved	with	
a	press	of	the	Memory	Recall	(MR)	button.	
Enter	14*16*MR	for	one	cost,	6*7*MR	for	
the	next,	and	2.5*3.5*MR	for	the	last.

7. Delete a digit
	 If	you	type	or	click	the	wrong	number,	
there’s	 no	 need	 to	 clear	 everything	 by	
clicking	on	Calculator’s	C	(for	“clear”)	key	
or	 pressing	 C	 on	 your	 keyboard.	 (If	 you	
have	a	full	Apple	keyboard,	you	can	also	
use	 the	 key	 labeled	 Clear.)	 Press	 Delete	
on	your	keyboard	 to	erase	 the	 last	digit	
you	 entered;	 press	 it	 multiple	 times	 to	
continue	erasing	digits.	(The	Forward	De-
lete	key	doesn’t	work	for	this.)

8. Quickly switch calculators
	 Click	on	 the	Calculator’s	Zoom	button	
(the	green	one	of	the	three	buttons	in	the	
upper	left	of	its	window)	to	cycle	through	
the	three	kinds	of	calculators—Basic,	Sci-
entific,	 and	Programmer—instead	of	us-
ing	the	commands	in	the	View	menu.

9. Easily change a mistake
	 If	you	enter	the	wrong	operator	by	mis-
take—pressing	 the	 plus	 sign	 (+),	 say,	 in-
stead	of	the	minus	sign	(-)—just	press	the	
correct	one	next.	Calculator	will	ignore	the	
first	operator.

10. Specify a negative number
	 Normally,	 you	 can’t	 calculate	 4	 multi-
plied	 by	 negative	 5,	 because	 4*-5	 is	 as-
sumed	to	be	a	typo	and	is	treated	as	4-5.	
But	you	can	reverse	the	“negativity”	of	a	

number	 you	 just	 entered	by	 clicking	on	
the	 Calculator’s	 plus-or-minus	 key.	 (It’s	
the	key	with	a	plus	sign	on	top	of	a	minus	
sign.	You’ll	find	it	to	the	right	of	the	C	key.)	
So,	press	4*5	and	then,	while	the	5	is	dis-
played,	click	on	the	plus-or-minus	key	to	
make	it	negative.	Press	Return	to	see	the	
answer:	-20.

Go figure!

The Tarmac Vaporware Gazette,	named	in	honor	of	past	presi-
dent	Jerry	Rowe,	is	published	each	month	by	Smitty’s	Printshop,	
a	non-existant	shop	specializing	in	things	of	little	or	no	impor-
tance	to	the	world	at	large.	Send	your	comments,	good	or	bad,	
to	smittysprintshop@mac.com.	
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	 AT&T’s	 exclusive	 hold	 on	 the	 iPhone	
is	 coming	 to	 an	 end,	 and	 speculation	 is	
bubbling	as	to	which	U.S.	carrier	will	get	
Apple’s	 smartphone	 next.	 Verizon	 has	
been	hot	tipped	to	take	over	the	iPhone,	
but	the	latest	iPhone-trashing	campaign	
for	 the	 Motorola	 Droid	 could	 mean	 it’s	
not	going	to	happen.	Now,	a	new	carrier	
has	emerged	as	a	possible	contender:	T-
Mobile.	Yes,	T-Mobile.
	 Analyst	Dough	Reid	tells	The	Street	that	
he	sees	T-Mobile	as	a	potential	home	for	
the	iPhone.	Like	AT&T,	T-Mobile	is	a	GSM	
carrier,	though	T-Mobile	is	a	much	smaller	
company.	Would	users	be	willing	to	make	
the	move	to	a	smaller	company?	We	may	
find	out,	according	to	Reid.
	 Reid	 told	 The	 Street:	 “Apple	 wants	 to	
move	 away	 from	 exclusivity;	 T-Mobile	
would	achieve	this	for	Apple	in	the	U.S.”	
And	it	makes	sense.	Apple	wouldn’t	have	
to	manufacture	a	different	iPhone	to	run	
on	T-Mobile’s	network,	as	the	GSM	version	
of	 the	 iPhone	 that	 runs	 on	AT&T	would	
work.	To	offer	the	iPhone	on	Verizon’s	net-
work,	Apple	would	have	to	manufacture	
a	new	device.

	 However,	 iPhone	 exclusivity	 on	
T-Mobile	 is	 doubtful.	 AT&T	 has	
around	71	million	customers	while	
T-Mobile	has	only	half	 as	many	users.	 It	
would	make	sense	for	Apple	to	sell	the	iP-
hone	on	both	AT&T	and	T-Mobile,	rather	
than	just	pick	one	single	carrier.
Users	 dissatisfied	 with	 AT&T’s	 network	
could	 just	move	 to	T-Mobile,	 as	 long	 as	
they	are	in	the	coverage	area.	And	so,	Ap-
ple	wouldn’t	have	to	manufacture	differ-
ent	 iPhone	hardware,	which	won’t	be	of	
much	use	to	sell	outside	the	U.S.	anyway,	
because	of	different	network	standards.
	 The	 model	 for	 selling	 the	 iPhone	 on	
more	 than	 one	 carrier	 comes	 from	 out-
side	the	U.S.	also.	O2,	now	the	largest	car-
rier	in	the	U.K.,	had	the	iPhone	exclusivity	
until	a	month	ago.	Orange	U.K.	then	sold	
30,000	 iPhones	 in	 the	 first	 weekend	 of	
carrying	the	device,	and	Vodafone	will	sell	
the	 iPhone	 starting	 January.	 In	 addition,	
T-Mobile	 UK	 and	 Orange	 are	 to	 merge,	
which	will	create	the	largest	UK	network,	
also	carrying	the	iPhone.	T-Mobile	in	Ger-
many	also	sells	the	iPhone.
	 With	 the	 foreign	 examples	 as	 a	 prec-
edent,	 the	multi-carrier	 iPhone	model	 is	
out	there.	Whether	Apple	will	bring	home	
this	model	though,	it	is	yet	to	be	seen.

The iPhone on T-Mobile: 
Why not?
12.01.09
Daniel	Ionescu		PC	World

That’s it for 2009!


